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 TUJUAN
1. Memahami Piranti ESP8266 
2. Memahami Blynk
3. Memahami penggunaan library Blynk
4. Memahami komunikasi ESP8266 dengan Blynk
5. Memanfaatkan Layanan Blynk untuk kendali dan monitoring Sensor.

B. DASAR TEORI
ESP8266
ESP8266 adalah sebuah embedded chip yang di desain untuk komunikasi berbasis wifi. Chip ini memiliki output serial TTL dan GPIO. ESP8266 dapat digunakan secara sendiri (Standalone) maupun digabungkan dengan pengendali lainnya seperti mikrokontroler. ESP8266 memiliki kemampuan untuk networking yang lengkap dan menyatu baik sebagai client maupun sebagai Access Point. Firmware yang dimiliki ESP88266 begitu banyak, dapat juga sebuah chip ESP8266 diprogram dengan tujuan khusus sesuai degan kebutuhan sebagai contoh kemampuan untuk berkomunikasi dengan web yang menggunakan port HTTPS.
Chip ESP8266 disempurnakan oleh Tensilica’s seri L106 Diamond dengan prosesor 32-bit. Ada 3 cara menggunakan ESP8266 : sebagai wifi access menggunakan AT command, dimana biasanya dimanfaatkan oleh Arduino untuk koneksi wifi, sebagai sistem yang berdiri sendiri menggunakan NodeMCU dan menggunakan bahasa LUA, sebagai sistem yang berdiri sendiri dengan menggunakan Arduino IDE yang sudah bisa terhubung dengan ESP8266. ESP 8266 dapat bertindak sebagai client ke suatu wifi router, sehingga saat konfigurasi dibutuhkan setting nama access pointnya dan juga passwordnya, selain itu ESP8266 dapat digunakan sebagai Access Point dimana ESP8266 dapat menerima akses wifi. 
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Gambar 1. ESP8266-1 AI Cloud dan Pin Konfigurasi
Fitur yang dimiliki oleh ESP8266-1 sebagai berikut : 
· Frekuensi wifi 802.11 b/g/n 
· Prosesor 32 - bit MCU 
· 10 - bit ADC 
· TCP/ IP protocol stack 
· TR switch, LNA , power amplifier dan jaringan 
· PLL , regulator , dan unit manajemen daya 
· Mendukung keragaman antena 
· WiFi 2.4 GHz , mendukung WPA / WPA2 
· Dukungan STA mode operasi /AP / STA + AP 
· Dukungan Smart link Fungsi untuk kedua perangkat Android dan iOS 
· SDIO 2.0 , ( H ) SPI , UART , I2C , I2S , IR Remote Control , PWM , GPIO 
· STBC , 1x1 MIMO , 2x1 MIMO 
· A - MPDU & A - MSDU agregasi & 0.4s guard interval

BLYNK
Blynk adalah sebuah layanan server yang digunakan untuk mendukung project Internet of Things. Layanan server ini memiliki lingkungan mobile user baik Android maupun iOS. Blynk Aplikasi sebagai pendukung IoT dapat diundung melalui Google play. Blynk mendukung berbagaimacam hardware yang dapat digunakan untuk project Internet of Things. Blynk adalah dashborad digital dengan fasilitas antarmuka grafis dalam pembuatan projectnya. Penambahan komponen pada Blynk Apps dengan cara Drag and Drop sehingga memudahkan dalam penambahan komponen Input/output tanpa perlu kemampuan pemrograman Android maupun iOS.
Blynk diciptakan dengan tujuan untuk control dan monitoring hardware secara jarak jauh menggunakan komunikasi data internet ataupun intranet (jaringan LAN). Kemampuna untuk menyimpan data dan menampilkan data secara visual baik menggunakan angka, warna ataupun grafis semakin memudahkan dalam pembuatan project dibidang Internet of Things. Terdapat 3 komponen utama Blynk
a. Blynk Apps
Blynk Apps memungkinkan untuk membuat project interface dengan berbagai maca komponen input output yang mendukung untuk pengiriman maupun penerimaan data serta merepresentasikan data sesuai dengan komponen yang dipilih. Representasi data dapat berbentuk visual angka maupun grafik.
Terdapat 4 jenis kategory komponen yang berdapat pada Aplikasi Blynk
· Controller digunakan untuk mengirimkan data atau perintah ke Hardware
· Display digunakan untuk menampilkan data yang berasal dari hardware ke smartphone
· Notification digunakan untuk mengirim pesan dan notifikasi.
· Interface Pengaturan tampilan pada aplikasi Blynk dpat berupa menu ataupun tab
· Others beberapa komponen yang tidak masuk dalam 3 kategori sebelumnya diantaranya Bridge, RTC, Bluetooth
b. Blynk Server
Blynk server merupakan fasilitas Backend Service berbasis cloud yang bertanggung jawab untuk mengatur komunikasi antara aplikasi smart phone dengan lingkungan hardware. Kemampun untuk menangani puluhan hardware pada saat yang bersamaan semakin memudahkan bagi para pengembang sistem IoT. Blynk server juga tersedia dalam bentuk local server apabila digunakan pada lingkungan tanpa internet. Blynk server local bersifat open source dan dapat diimplementasikan pada Hardware Raspbery Pi.
c. Blynk Library
Blynk Library dapat digunakan untuk membantu pengembangan code. Blynk library tersedia pada banyak platform perangkat keras sehingga semakin memudahkan para pengembang IoT dengan fleksibilitas hardware yang didukung oleh lingkungan Blynk
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Gambar 2 Blynk Cloud Server

C. ALAT DAN BAHAN 
1. Blynk Apps (Android)
2. ESP8266 AI Cloud Inside / NodeMCU
3. Arduino UNO
4. Input Output Sensor
5. Project board
6. Access Point
7. Jumper secukupnya


D. LANGKAH KERJA
[image: ]Berikut ini langkah-langkah yang harus dilakukan
1. Konfigurasi Blynk
a. Mengunduh aplikasi Blynk dan Registrasi akun
Aplikasi Blynk untuk android dapat diunduh di https://play.google.com/store/apps/details?id=cc.blynk 
Setelah selesi intalasi langkah berikutnya adalah mendaftar akun di server Blynk melalui Aplikasi Blynk Apps. Register akun dapat menggunakan akun Facebook maupun menggunakan email. Apabila membuat akun melalui Email username pada saat login adalah email yang sebelumnya didaftarkan pada server Blynk.
Setelah selesai membuat akun dan verifikasi email, langkah berikutnya adalah login pada aplikasi Blynk kemudian membuat sebuah project melalui menu pilihan New Project. Masukan isian nama project dan juga nama device yang akan digunakan pada sistem IoT.
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Gambar 3. Membuat akun dan Project di Aplikasi Blynk

Untuk menghubungkan device IoT dengan server Blynk dibutuhkan kode keamanan Authentication yang dikirimkan dari server blynk ke email melalui Project Setting pada menu AUTH TOKEN. Menu Project Setting terdapat pada icon nomor 3 dari kanan [image: ] . Menu yang lainya adalah segitiga digunakan untuk Play Aplikasi Project dan menu Plus digunakan untuk menambah komponen dalam project Aplikasi Blyk. Kode AUTH TOKEN dapat didapatkan melalui pengiriman email ataupun langsung dicopy melalui Aplikasi Blynk. Auth Token yang dikirimkan melalui email atau langsung copy dari aplikasi nanti akan dimasukkan kode program yang dimasukkan dalam ESP8266
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Gambar 4. Auth Token dan Widget di Blynk

Untuk menambah komponen input output project dapat menggunakan menu plus yang ada didalam lingkaran. Terdapat berbagaimacam komponen diantaranya Button , Slider, Vertical Slider, Value Display dan juga komponen graphic. Berbagai macam komponen yang tersedia disesuaikan dengan credit power yang masih tersisa. Credit power pada saat registrasi diberikan sejumlah 2000. Untuk topup credit power dapat menggunakan google play credit.

[image: ][image: ]Menambahkan komponen Value Display dengan cara drag and drop pada komponen yang tersedia, selanjutnya melakukan konfigurasi komponen value display pin menjadi Virtual Pin V1
Komponen ini digunakan untuk menampilkan data yang nanti akan dikirimkan dari hardware ke Aplikasi Blynk




[image: ][image: ]Menambahkan komponen Slider Display dengan cara drag and drop pada komponen yang tersedia, selanjutnya melakukan konfigurasi komponen value display pin menjadi Virtual Pin V0 

Komponen Slider ini akan digunakan untuk mengirimkan data dari Aplikasi Blynk ke hardware ESP8266

2. Konfigurasi IDE Arduino 
ESP8266 dapat di program dengan menggunakan Arduino IDE. Arduino IDE standard tidak memiliki library ESP8266 dan Blynk sehingga sebelum memrogram ESP8266 menggunakan Arduino IDE harus dilakukan instalasi addon ESP8266 Library dan Blynk Library.
a. Instalasi addon ESP8266 dengan Arduino Board Manager
Untuk install library ESP8266 buka Arduino IDE kemudian masuk ke menu preferences (File > Preferences). Kemudian dibagian bawah jendela masukkan url berikut ini ke Additional Board Manager URLs
http://arduino.esp8266.com/stable/package_esp8266com_index.json

[image: ]
Setelah menambahkan URL pada Additional Board Manager kemudian masuk ke menu Board Manager (Tools > Boards > Boards Manager). Kemudian cari ESP8266 pada Filter untuk memudahkan pencarian. Setelah itu klik Install.
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b. Memilih board ESP8266
Setelah menambahkan board ESP8266 kedalah IDE selanjutnya memilih board ESP8266. Dalam praktikum ini jenis ESP8266 yang digunakan pada IDE adalah Generic ESP8266 Module. Untuk seting yang lainya seperti pada gambar. 

[image: ] 

3. Install Library Blynk 
Pada saat memrogram ESP8266 yang mampu berkomunikasi dengan Blynk Apps digunakan library Blynk ardunio sketch. Library Blynk untuk arduino dapat diunduh melalui menu Sketch  Include Library  Manage Libraries. 
[image: ]

Dilanjutkan dengan pencarian dengan keyword Blynk pada isian pencarian.

[image: ]
Library Blynk terbaru saat ini adalah Version 0.4.7
Apabila instalasi library Blynk sudah selesai Menu Library Blynk pada Sketch  Include Library  Blynk sudah tersedia.
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4. Menggunakan Example program Blynk Untuk ESP8266
Didalam library Blynk yang sudah diinstall sebelumnya juga terdapat contoh program untuk menggunakan ESP8266 yang berkomunikasi dengan Blynk Apps. Contoh program ada pada file FirebaseDemo_ESP8266 (File > Examples > Blynk > Boards_Wifi > ESP8266_Standalone) 

[image: ]

#define BLYNK_PRINT Serial
#include <ESP8266WiFi.h>
#include <BlynkSimpleEsp8266.h>

// You should get Auth Token in the Blynk App.
// Go to the Project Settings (nut icon).
char auth[] = "Auth_Token";

// Your WiFi credentials.
// Set password to "" for open networks.
char ssid[] = "SSID";
char pass[] = "PASSWORD";

Terdapat beberapa baris kode program yang harus diganti dan disesuaikan dengan konfigurasi Authentication Token dari Blynk Apps dan akses point internet yang digunakan. 

void setup()
{
  // Debug console
  Serial.begin(9600);

  Blynk.begin(auth, ssid, pass);
  //You can also specify server:
  //Blynk.begin(auth, ssid, pass, "blynk-cloud.com", 8442);
  //Blynk.begin(auth, ssid, pass, IPAddress(192,168,1,100), 8442);
}

void loop()
{
  Blynk.run();
}

BLYNK_WRITE(V0) //Button Widget is writing to pin V1
{
  int pinData = param.asInt(); 
  Serial.print("Slider :");
  Serial.println(pinData);
}

BLYNK_READ(V1) 
// Widget in the app READs Virtal Pin V5 with the certain frequency
{
  // This command writes Arduino's uptime in seconds to Virtual Pin V5
  int n = random(100);
  Serial.println(n);
  Blynk.virtualWrite(1, n);
}


5. Memogram ESP8266 menggunakan Arduino UNO R3 sebagai interface
Untuk memrogram ESP8266 menggunakan melalui board Arduino UNO R3 dapat dilakukan dengan menghubungkan ESP8266 dengan Arduino UNO R3. Catatan, IC ATMEGA di Arduino UNO R3 harus dilepas terlebih dahulu pada saat memrogram ESP8266.
Berikut ini adalah gambar rangkaian ESP8266 dengan Arduino UNO R3 (chip IC AT MEGA dilepas) pada saat proses memrogram ESP8266
[image: ../../../2%20Penelitian/Journal%20muiez/Firebase%20IoT/ESP8266.%20Arduino.jpg]
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6. Menjalankan ESP8266 pada sistem rangkaian tersendiri
Berikut ini adalah gambaran sistem yang di coba.
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Pada saat rangkaian dijalankan pin ESP GPIO 0 tidak dihubungkan ke GND.
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Contoh program ESP8266 diatas dapat dilihat pada saat menggunakan serial monitor Arduino IDE. 
[image: ]
Berikut ini adalah tampilan awal serial monitor ESP8266 ketika sudah terhubung ke server Blynk. Apabila Tulisan Ready belum ada berati ESP8266 berlum terhubung ke Bynk Server.
[image: ]  [image: ][image: ]

Hardware ESP8266 akan mengirimkan data random dan ditampilkan pada Aplikasi Blynk lewat komponen Value Display melalui port Virtual V1. Sedangkan Slider pada Aplikasi jika slider dipindah posisi maka Blynk akan mengirimkan data posisi slider ke Hardware ESP8266 dan dapat dilihat pada serial data monitor.



Perhatikan fungsi

BLYNK_WRITE(V0) //Button Widget is writing to pin V1
{
  int pinData = param.asInt(); 
  Serial.print("Slider :");
  Serial.println(pinData);
}

BLYNK_READ(V1) 
// Widget in the app READs Virtal Pin V5 with the certain frequency
{
  // This command writes Arduino's uptime in seconds to Virtual Pin V5
  int n = random(100);
  Serial.println(n);
  Blynk.virtualWrite(1, n);
}

Perintah BLYNK_WRITE digunakan pada saat Aplikasi Blynk mengirimkan data ke hardware. Sedangkan perintah BLYNK_READ digunakan ketika kita menginginkan hardware mgnirimkan data ke Aplikasi Blynk

E. LATIHAN
1. Pelajari dokumen Library Blynk pada alamat http://docs.blynk.cc 
2. Lankukan Percobaan untuk mengendalikan Hardware dan merubah konfigurasi pada komponen baik Digital Pin maupaun Analog Pin
3. Coba implementasikan seluruh fungsi yang ada di dalam dokumentasi library
4. [bookmark: _GoBack]Gabungkan sistem ESP8266 – Blynk – Android untuk sistem kontrol dan monitoring untuk implementasi sistem.Internet of Things.
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ESPB266 FeaTuRES:

© 32 BIT CPU @ BOMHZ

© 64 KB COMMAND RAM

. 96 KB DATA RAM

- EXTERNAL QPI FLASH
USUALLY 512KB
ur To amBIT

- IEEE BOZ.AA 8/G/N WIFI
2.46HZ, WEP/WPAWPAZ

- UP T0 16 GPIO PiNs

- SPI, 12C, 178, UART

- 10-aiT ADC

ESPO1 FeaTuRES:
. 2x4 DIL HEADER
* INTEGRATED ANTENNA
* INTEGRATED LED (Vgg, TXD)
© USUALLY 512KB or
1MB FLash

PINOUT

OPERATING

Vet 3.3V (e To 200MA)

10 AND UART ARE NOT 5V TOLERANT
CH_PD (AKA ENABLE) MUST BE PULLED HIGH

MODULE VARIANTS
ESPOIVI:
ONLY Vo, GND, RXD AND TXD CONNEGTED

CAN NOT BE FLASHED WITHOUT MODIFIGATION
ESPOIvZ:

CONNEGTIONS AS SHOWN HERE

BooT MODES

PINS MUST BE PULLED TO THE

GPIOIS GPIOD  GPIOZ | Made

LW LW HIGH  Serial Programing
LW WG WIGH Boot from Flash
WGH AN A oot from SD-Card

1015 15 connected to GND on ESP-01
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